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Notice on the guaranties and copyrights

Information contained in this manual are given for informational use only, and are 
subject to change at any time without notice and should not be construed as a commitment of the 
vendor.

No responsibility or liability is assumed for any errors or inaccuracies that may 
appear in this manual, including the products and software described in it.

Products  and  corporate  names  appearing  in  this  manual  may  or  may  not  be 
registered  trademarks  or  copyrights  of  their  respective  companies,  and  are  used  only  for 
identification or explanation and to the owners' benefit, without intent to infringe.

No part of this manual, including the products and software described in it, may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language 
in any form or by any means, except documentation kept by the purchaser for backup purposes, 
without the express written permission of the authors.
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1 About this manual
1.1 Icons used in this manual

The following icons are used within this manual for complementary information.

 The icon "Important", represented by an exclamation mark, is used for important information on 
the use of the software.

 The icon "Remark", represented by a bug, is used for complementary information, for example 
another way to do the same thing.

 The icon "Tip", represented by an electric light bulb, is used for information allowing you to work 
more efficiently with the software.

1.2 Presentation

The application allows you to easily design human machine interfaces for the industrial 
gateways. Once the designed interfaces charged into the gateway, they can be accessed through an 
Internet Explorer browser, real-time animated and they allows to control the industrial installation.

The application manages projects, a project being a set of synopsis that would be charged 
into the gateway. A synopsis is composed by graphical elements to which animations are associated, 
as it is usually the case of the common supervision software. 
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2 The Workspace
This application is an environment that integrates a graphical editor. The environment is 

divided into four areas, as shown in the following figure:
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3 The Menu Bar
The menu bar consists of seven menus: File, Edit, View, Action, Animation, Window, Help 

(see Figure 3.1).

If no synopsis is opened, the menus associated to the graphical editor are hidden. Only the 
menus File, Edit, Window and Help are visible.

3.1 The « File » Menu
This menu allows the user to manage the projects and the synopsis. The menu is shown in 

the figure Figure 3.2.

The File menu contains the following items:

New project: Creates a new project.

New synopsis: Creates a new synopsis. This is included in the currently selected project.

Save: Saves the last modifications of the synopsis currently selected in the graphical editor. This 
item is gray (not available) if the synopsis currently chosen in the graphical editor is not modified.
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Save All:  Saves the modifications of all synopsis opened in the graphical editor. This item is gray 
(not available) if no synopsis is modified.

Close: Closes the synopsis currently chosen in the graphical editor.

Close All: Closes all synopsis opened in the graphical editor.

Exit: Closes the application. If one or more opened synopsis are modified, the user is asked for 
saving these synopsis.

3.2 The « Edit » Menu
The  actions  of  this  menu  concern  the  edition  of  the  synopsis  currently  chosen  in  the 

graphical editor. The Figure 3.3 shows this menu.

The Edit menu contains the following items:

Undo xxx: Cancels the action xxx which was lastly executed in the synopsis currently chosen in the 
graphical editor.

Redo: Redoes the action which was lastly executed in the synopsis currently chosen in the graphical 
editor.

Copy: Copies the element currently chosen in the graphical editor.

Cut: Cuts the element currently chosen in the graphical editor.

Paste: Pastes the lastly  copied or  cut element in the synopsis currently chosen in the graphical 
editor.

Delete: Deletes the element currently chosen.

Select All: Selects all the elements in the synopsis currently chosen in the graphical editor.
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Properties: Shows the properties window of the element currently chosen in the graphical editor.

The actions Copy, Cut, Paste, Delete are enabled for the graphical elements of a synopsis, 
and also for the elements of the project browser.

3.3 The «View» Menu
The actions of this menu concern the customization of the graphical editor.

The Figure 3.4 shows this menu.

The View menu contains the following items:

Zoom In: Zooms the view on the graphical editor. This item is gray (not available) if the maximum 
zoom is already reached.

Zoom Out: Zooms out the view on the graphical editor. This item is gray (not available) if  the 
minimum zoom is already reached.

Rulers: Toggles the display of the rulers.

Grid  parameters:  Displays  the  grid  parameters  window,  which  allows  the  user  to  set  the 
width/height of the grid, to activate its magnetic behavior, to define its horizontal and vertical 
magnetic influences.

Grid: Toggles the display of the grid.
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3.4 The «Actions» Menu
The actions of this menu concern the organization of the elements in the graphical editor. 

The  actions  allow  the  user  to  manage  the  superposition  levels  for  the  graphical  elements,  to 
group/ungroup the objects,  or  to align elements with respect  to the position of  one reference 
element. The Figure 3.5 shows this menu.

The Actions menu contains the following items:

Group: Groups the elements currently selected in the graphical editor. This item is enabled when at 
least two elements are selected.

Ungroup: Ungroups the element currently selected. The item is enabled when exactly one group 
element is selected.

Move backward: Moves backward the currently selected element in the graphical editor, by one 
level.

Move forward: Moves forward the currently selected element in the graphical editor, by one level.

Move to  back:  Moves  backward the  currently  selected element  in  the  graphical  editor,  to  the 
bottommost level.

Move to front: Moves forward the currently selected element in the graphical editor, to the topmost 
level.
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Lock:  Locks  the  currently  chosen element,  making it  to  act  as  a  container:  elements  that  are 
superposed can be selected by a selection action.

Unlock: Unlocks the currently chosen element. Elements that are superposed can not be any more 
selected by a selection action.

Align  Left:  Aligns  left  the  selected  elements  in  the  graphical  editor,  with  respect  to  the  last 
selected element.

Align Center: Aligns center the selected elements in the graphical editor, with respect to the last 
selected element.

Align Right: Aligns right the selected elements in the graphical editor, with respect to the last 
selected element.

Align Top: Aligns top the selected elements in the graphical editor, with respect to the last selected 
element.

Align Middle: Aligns middle the selected elements in the graphical editor, with respect to the last 
selected element.

Align Bottom: Aligns bottom the selected elements in the graphical editor, with respect to the last 
selected element.

Match Width of Figures : Sets the width of the selected figures to the width of the last selected 
element. This item is available only if more than one object are selected and, at least one allows 
automatical resize (the following objects do not allow automatic resize: polygon, polyline, line ...).

Match Height of Figures : Sets the height of the selected figures to the height of the last selected 
element. This item is available only if more than one object are selected and, at least one allows 
automatical resize (the following objects do not allow automatic resize: polygon, polyline, line ...).

These items are not enabled if no element is selected in the graphical editor.

3.5 The « Animation » Menu
The actions of this menu allow the animations to be associated to the element currently 

selected in the graphical editor. Only the items corresponding to animations that can be associated 
to the currently selected element are enabled.

12 User Manual



The animations are described in the chapter 8.1 (page 47).

3.6 The « Window » Menu
The action of this menu allows to reinitialize the application window, displaying all the 

application views. The Figure 3.7 shows this menu.

3.7 The « Help » Menu

The Help menu contains the following items:

Help Contents: Opens a new window with the user manual (not yet implemented).

About: Displays a window showing information on the version of the application and also the type of 
the license registered.
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4 The Toolbar
The toolbar is situated in the main window, under the menu bar. The toolbar allows the 

easy access to some functionalities from the menus that are described in the previous chapter.

The tooltips identify the function of each item of the toolbar.
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5 Synopsis Management
This application manages a set of  projects, each project being constituted by a set of 

synopsis.

5.1 The project browser

The projects created are visible in the Projects Explorer view. This view displays as a tree 
the projects and, for each project its synopsis.

When a new project or a synopsis is created, it is automatically added in the project tree.

The application manages on its own the data savings. This means that the user does not 
have to choose the file to which the data is saved. When you open the application, all the projects 
created  previously  are  available.  The  projects  are  saved  in  the  workspace  directory  of  the 
installation software directory.
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5.2 Creating a new project

To create a new project:

1. Open the contextual menu of the Project Explorer view and choose New project.

2.  Enter the project name in the text field prompted and then click Ok.

3. The project created appears in the Project Explorer view.

5.3 Creating a new synopsis
To create a new synopsis:

1. Select the project for which the new synopsis should be created in the Project Explorer 
view.

2. Open  the  contextual  menu  in  the  Projects  Explorer view,  by  a  right  click  on  the 
selected project, and choose New synopsis.

3.  Enter the synopsis name in the text field prompted and then click Ok.

4. The synopsis created appears in the Project Explorer view.
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In order to open a synopsis, double click on it in the Project Explorer view. The selected 
synopsis is opened in the graphical editor.

The synopsis name can not contain blanks.

The actions for creating a new project or synopsis are also available in the File menu of the 
menu bar.

5.4 Setting the parameters of a project

A project is intended to be transferred to a gateway, in order to display and animate its 
synopsis. It is than necessary to specify the gateway address into the network in order to transfer 
the synopsis, and also the animation parameters.

To display the properties window of a project, open the contextual menu of the project, 
and select the Properties item.
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The project properties window (see Figure 5.3) contains two tabs. The first one concerns 
the animation parameters, the second one the gateway parameters.

5.4.1 The Project Properties Tab

This tab (see  Figure 5.3) allows to specify the animation parameters in the synopsis of a 
project.

1. Check the box Show animation control panel in order to display the animation control 
panel in the synopsis, at runtime.

2. Check the box Default animation state in order to have the synopsis automatically ani­
mated when  opened.

3. The  text  field  Animation  rate allows  to  set  the  refresh  rate  of  the  animation,  in 
milliseconds.

5.4.2 The Export Properties Tab

This tab (see Figure 5.4) allows to specify the information for the gateway.
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Enter the following gateway information:

1. Enter in the Address text field the IP address or the domain name of the gateway.

2. If the gateway FTP server needs authentication, fill in the text fields User and Password 
to use when transferring the files.

3. Enter in the Connection timeout text field the maximum waiting duration (in seconds) 
for a gateway response (e.g. : 30  for a connection timeout of 30 seconds).

5.4.3 Licensing

The export properties tab allows the user to display the licensing window (see Figure 5.5), 
from which the user can download/transfer/check a license on his/her module.

In order to download a runtime license, the user should:

1. fill in with his/her personal data : Name, Company, Function, Phone, Email

2. enter the license code received from his/her distributor

3. enter the mac address of the module. The mac address can be written using blanks, or 
one of the separators “:”, “-”. E.g. The mac address 003011025E07 can also be written in one of 
the following formats: 00:30:11:02:5E:07,  00 30 11 02 5E 07,  00-30-11-02-5E-07.
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4. choose a directory in which the license should be downloaded

5. click on the “Get runtime license” button. Then, the license file “runtime.txt” is saved 
in the directory chosen by the user.

The user must have an internet connection in order to download the license file.

In  order to  transfer  a  runtime license  from his/her  computer  to  the  module,  the  user 
should:

1. fill in the ip address of the module. This can be done either manually or automatically 
using the IPconfig tool, which is accessible through the “...” button

2. enter the ftp login/password, if appropriate

3. choose the license file to be transferred

4. click the “Transfer runtime license” button

In order to check if a valid runtime license exists on the module, the user should:

1. fill in the ip address of the module. This can be done either manually or automatically 
using the IPconfig tool, which is accessible through the “...” button

2. enter the ftp login/password, if appropriate

3. click the “Check runtime license” button
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6 Widget Management

A widget is an entity defined by the user for re-use. It is possible to build libraries of such 
graphical complex elements, that could be re-used in many synopsis.

A widget is a set of objects and their associated animations. The variables of the animations 
are symbolic names, that will be replaced by existing variables after inclusion of the widget in a 
synopsis.

6.1 Widgets Browser
This view shows the structure of the widgets directory, called lib. It also shows, in the 

bottom area a visual preview of the widget currently selected in the top tree.

The widgets are files that have an .tml extension. They are organised in directories. In the 
contextual  menu,  there  are  items  that  allow  to  copy/cut/paste/delete/create  a  widget  or  a 
directory. To move or copy a widget or directory to another directory, drag and drop by mouse are 
allowed. 

The next figure shows the structure of the widgets library installed by default. 
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6.1.1 Creating a New Widget

4. Select a directory in the widgets browser tree

5. Right click on a directory; the contextual menu shows. Select « New widget »

6. Enter the name of the new widget and click Ok

7. The created widget appears in the Widgets Browser view

The name of a widget may not contain blank spaces or stress mark characters.

6.2 Editing a Widget
In  order  to  open an existing  widget  for  edition,  double click  on  the widget  in  the Widgets 
Browser View. The widget is  open for  edition in the graphical  editor. The behaviour of  the 
graphical editor is the same for the widget as for the synopsis: the objects and their animations 
can be edited, deleted...

6.2.1 Defining the Dimensions of the Widget

1. In a widget opened for edition, right click to show the contextual menu. Select the 
« Properties » item. The following dialog shows:

2. Choose a new size for the widget and then choose OK
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6.2.2 Adding an Animation

The same steps are to be followed when editing a widget or a synopsis, in order to associate 
an animation to an object. The difference is that, when editing a widget, the variable names are 
symbolic names which will be mapped to real variables after instanciating the widget in a synopsis.

In the « purge » widget (which is included by the default installation of the software) , the 
variable « opened » is a symbolic name.

A symbolic name can be used one time in a widget.

6.3 Including a Widget in a Synopsis
In order to include a widget in the currently edited synopsis:

1. Select the widget in the widgets browser tree.

2. Drag and drop this widget in the graphical editor area

3. Release the mouse button, in order to place the widget in the chosen position 
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The widget object in a synopsis is stocked as a link to the widget. That means that all 
modifications of the widget will be seen in the synopsis.

If the widget is modified while the synopsis that contains a link to this widget is opened, 
than the modifications of the widget will be visible in the synopsis only after closing and re-opening 
the synopsis.

6.4 Defining Parameters of the Widgets
Parameters should be defined for each symbolic variable name of the widget. This symbolic 

name should be mapped to an existing variable on the gateway. 

1. Select the widget in the synopsis

2. Display the properties dialog of the widget

3. Click on the button   in order to open the variable browser

It is also possible to modify some of the parameters of the widgets animations. In the shown 
example, "level.Max value" represents the parameter "Max value" of the bargraph animation to which 
the symbolic variable 'level' is binded. 
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7 The Graphical Editor
In order to open a synopsis, double click on a synopsis in the Project Explorer view. The 

graphical editor contains all the graphical tools needed for designing synopsis.

7.1 The synopsis editor
This view displays all opened synopsis in a tab manner. The workspace is divided in two 

parts: the edition zone and a toolbar, showing the available objects and the animations that can 
be associated to them (see Figure 7.1). As in the common drawing environments, in order to draw 
an object,  select  it  first  from the  toolbar,  than put  it  into  the  design  area  and configure  its 
properties.

Each element has some specific properties, which can be edited in the window opened by 
the item Properties of the contextual menu of this selected element.
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7.2 The outline view
The outlines view displays  an overview of the synopsis  currently selected. This  view is 

useful especially if the synopsis is zoomed.

The Figure 7.2 shows the outline view. The area delimited by a blue rectangle indicates the 
visible part of the synopsis in the graphical viewer.

7.3 The drawing functionalities

7.3.1 Common Principles

All  graphical  elements  have a  contextual  menu,  which  allows  to  access  functions  like: 
Copy/Cut/Paste, Group/Ungroup, Alignment, Lock/Unlock...
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When an object is locked, it is possible to select an object on its top (superposed). When 
created, objects are unlocked. The lock function allows, for exemple, to have an image in the 
background of the synopsis and work on the objects superposed to the image.

All  graphical  elements  have some properties  available  from the  contextual  menu.  The 
properties can be specific to an element, or common to some elements.

There are two types of graphical elements:

4. Elements of type « line » (see  Figure 7.4):  Line, Multiline, Polyline, Polygon, Bezier 
Curve, Bezier Shape.

5. Elements  of  type « shape »  (see  Figure  7.3):  Image,  Quarter ellipse,  Text,  Ellipse, 
Rectangle, Half ellipse, Entry field, Button.

(*) : Rotation centre, used by the rotation animations (see chapter 8.6.7).

When selecting a shape, an enclosing frame is displayed(see Figure 7.3). The frame contains 
eight resizing handles. 

The frame properties are defined in the first  tab  of  the « shape » elements  properties 
window.
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« Shape » elements properties window

The Figure 7.5 shows the first tab of the « shape » elements properties window.

This tab allows to display/modify the information concerning the frame of the selected 
element. These values are in pixels. The origin of axes is the top left point in the graphical editor.

« Line » elements properties window

The « line » elements are not inscribed in a frame when selected. Only the transformation 
point coordinates are displayed in the first tab of the properties window. Exception to the rule is the 
Line object which is inscribed in a rectangle of which it is the diagonal.

Common properties

All graphical elements have style properties concerning the appearance of the element. 
These properties concern the stroke colors, the stroke style and size and, the fill  color for the 
« shape » elements.

The Figure 7.6 shows the tab Style of the Properties window, in which the style parameters 
can be viewed and set.

30 User Manual

Figure 7.5



To modify the style of an element: 

1. Select the object to modify.

2. Right click to display the contextual menu and choose Properties.

3. Select the Style tab (see Figure 7.6).

4. The combo box Style allows to select the line style to use for the element stroke: 

1. Solid: 

2. Dash:

3. Dash-dot:

4. Dash-dot-dot:

5. Dotted:

6. Invisible: 

5. Fill in the Size text field, the size of the element stroke, in pixels.

6. Click on the  button. The color editor window prompts.

7. Choose a color.

8. Click on the OK button to validate the selection.

9. Click on the OK button to validate the modifications for this object.
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All « shape » elements are resizable by the eight handles around the frame. All elements 
have a special handle, surrounded by a circle, that represents the rotation centre of the element 
(e.g. transformation point). The position of this point can be changed.

7.3.2 The « Image » Object

Inserting an « Image » object

To insert an image object into the currently edited synopsis:

1. Click on the Image tool on the graphical editor toolbar (see Figure 7.7).

2. Click on the drawing area and, while maintaining the left mouse button pressed, draw 
the rectangular frame into which your image will be placed. Then release the mouse button.

Modifying the properties of an Image object

To modify the properties of an Image object:

1. Select the Image object to modify.
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2. Right click to display the contextual menu and choose Properties.

3. Select the Properties tab (see Figure 7.8).

4. Click on the selection image button. A file chooser dialog window is displayed.

5. Select your image and choose Open.

6. If you wish your image not to be resizable, check the box: Keep original size.

7. If you wish your image to be resizable but keeping the width/height proportions, check 
the box: Keep ratio.

8. Click OK  to validate your changes.

Once the image added to the synopsis, it is integrated into the project. The image becomes 
than independent on its original source image.

The check box  Keep original size prevents the resizing of the image, so it cancels the 
action of the Keep ratio check box.

7.3.3 The « Line » object

Inserting a Line object

To insert a line object into the currently edited synopsis:

1. Click on the Line function on the graphical editor toolbar (see Figure 7.9).

2. Click on the drawing to put the first point of the line. 

3. Move you mouse in the drawing area and finally click again to finish drawing the line.

Modifying the properties of a Line object

To modify the properties of a Line object:
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1. Select the Line object to modify.

2. Right click to display the contextual menu and choose Properties.

3. Select the Main parameters tab (see Figure 7.5)

4. Modify the parameters.

5. Click on the OK  button to validate the changes.

7.3.4 The « Polygon » object

Inserting a Polygon object

To insert a polygon object into the currently edited synopsis:

1. Click on the Polygon function on the graphical editor toolbar (see Figure 7.10).

2. Click on the drawing are to put the first point of the polygon. Release the mouse button.

3. Move the mouse in the drawing area till the next point of the polygon and click again to 
set this point.

4. Repeat the third step to set as many points as you wish for the polygon and finally 
double click in order to finish drawing the polygon.

Modifying the properties of a Polygon object

To modify the properties of a polygon object:

1. Select the Polygon object to modify.

2. Right click to display the contextual menu and choose Properties.

3. The  polygon  is  a  « line »  object,  so  only  the  tabs  Main  parameters  and Style  are 
available (see  Figure 7.5 and  Figure 7.6). Modify the parameters, as explained in the  « Line »
elements properties window paragraph.
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4. Click on the OK button to validate your modifications.

7.3.5 The « Quarter ellipse » object

Inserting a Quarter ellipse object

To insert a quarter ellipse object into the currently edited synopsis:

1. Click on the Quarter ellipse function on the graphical editor toolbar (see Figure 7.11).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the 
rectangular  frame into  which  your  Quarter  ellipse  will  be  placed.  Then release  the  mouse 
button.

Modifying the properties of a quarter ellipse object

To modify the properties of a Quarter ellipse object:

1. Select the  Quarter ellipse object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Select the  Properties tab (see Figure 7.12).

4. The combo list Orientation allows to select the type of the quarter ellipse to display: 

1.  Bottom left : to display the quarter ellipse  in the bottom left corner of 

the ellipse.

2.  Bottom right : to display the quarter ellipse  in the bottom right corner of 

the ellipse.

3.  Top left : to display the quarter ellipse  in the top left corner of the ellipse.

4.  Top right : to display the quarter ellipse   in the top right corner of the 

ellipse.
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5. Check the checkbox  Closed,  if  you wish the outline to  be displayed all  around the 
quarter ellipse. 

6. Click on the OK button to validate your modifications.

7.3.6 The « Text » object

Inserting a Text object

To insert a text object into the currently edited synopsis:

1. Click on the Text function on the graphical editor toolbar (see Figure 7.13).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the 
rectangular frame into which your Text will be placed. Then release the mouse button.

Modifying the properties of a Text object

To modify the properties of a Text object:
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1. Select the Text object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Select the  Properties tab (see Figure 7.14),

4. Enter in the Text entry field the text to be displayed.

5. The combo list Horizontal alignment allows to select the horizontal position of the text 
in its frame.

1.  Left: to display the text in the left part of the frame. 

2.  Centre: to display the text in the centre part of the frame.

3.  Right: to display the text in the right part of the frame.

6. The combo list Vertical Alignment allows to select the vertical position of the text in its 
frame.

1. Top: to display the text in the top part of the frame.

2. Centre: to display the text in the centre part of the frame.

3. Bottom: to display the text in the bottom part of the frame.

7. Click on the OK button to validate your modifications.
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Modifying the font of the text:

To modify the properties of a Text object:

1. Select the Text object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Select the  Properties tab (see Figure 7.14).

4. Click on the                  button . The font window is displayed (see Figure 7.15).

5. Select the Font, Style and Size of the text.

6. The combo list Text decoration allows to choose the following options:

1. None: displays the text without decoration.

2. Overline: displays the text overlined.

3. Underline: displays the text underlined.

4. Line-through: displays the text striked.

7. Click on the OK button to validate your font modifications.

8. Click on the OK button to validate your modifications for the Text object.
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3. Select the  Properties tab (see Figure 7.14).

4. Click on the             button. The color window is displayed.

5. Select a color.

6. Click on the OK button to validate the color modifications.

7. Click on the OK button to validate your modifications for the Text object.

7.3.7 The « Ellipse » 

Inserting an Ellipse object

To insert an Ellipse object into the currently edited synopsis:

1. Click on the Ellipse function on the graphical editor toolbar (see Figure 7.16).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the rectan­
gular frame into which your Ellipse will be placed. Then release the mouse button.

Modifying the properties of an Ellipse object

To modify the properties of an Ellipse object:

1. Select the Ellipse object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Enter your parameters in the Main parameters and Style tabs (see Figure 7.5 and Figure
7.6).

4. Click on the OK button to validate your modifications.
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7.3.8 The « Rectangle » object

Inserting a Rectangle object

To insert a Rectangle object into the currently edited synopsis:

1. Click on the Ellipse function on the graphical editor toolbar (see Figure 7.17).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the 
rectangular frame into which your Rectangle will be placed. Then release the mouse button.

Modifying the properties of a Rectangle object

To modify the corner curvature properties of a Rectangle object:

1. Select the Rectangle object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Select the tab Properties (see Figure 7.18).

4. Modify the values X-Axis curvature and Y-Axis curvature.

5. Click on the OK button to validate your modifications.
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The Figure 7.19 shows the different corner curvatures of the rectangle object.

Modifying the advanced properties of a Rectangle object:

To modify the advanced properties of a Rectangle object:

1. Select the Rectangle object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

1. Select the Advanced Style tab (see Figure 7.20).
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2. The combo list Style proposes different styles :

1. No style : No special style is displayed for the rectangle.

2. Shadow : Adds a shadow effect to the rectangle.

3. Button : Adds a button effect to the rectangle.

3. Enter the width of the stroke in the Stroke size entry field.

4. The button Top left stroke color allows to select the color of the top left border when 
the Button style is activated.

5. The button  Bottom right stroke color allows to select the color of the bottom right 
border when the Button or Shadow is activated.

7.3.9 The « Half ellipse » object
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Inserting a Half ellipse object

To insert a Half ellipse object into the currently edited synopsis:

1. Click on the Half ellipse function on the graphical editor toolbar.

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the 
rectangular frame into which your Half ellipse will be placed. Then release the mouse button.

Modifying the properties of a Half ellipse object

To modify the properties of a Half ellipse object:

1. Select the Half ellipse object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. Select the tab Properties tab (see Figure 7.22).

4. The combo list Orientation allows to select the type of the half ellipse: 

• Left : to display the half left side ellipse.  

• Right: to display the half right side ellipse.  

• Top: to display the half top side ellipse.  

• Bottom: to display the half bottom side ellipse. 

5. Check the checkbox Closed, if you wish the outline to be displayed all around the half 
ellipse. 

6. Click on the OK button to validate your modifications.
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7.3.10 The « Entry field » object

Inserting an Entry field object

To insert an Entry field object into the currently edited synopsis:

1. Click on the Entry field function on the graphical editor toolbar (see Figure 7.23).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw the 
rectangular frame into which your Entry field will be placed. Then release the mouse button.

Modifying the properties of an Entry field object

The Entry field has the same graphical properties as the Text object, please refer to the 
Text chapter to see how to modify the Entry field properties.

7.3.11 The « Button » object

Inserting an Button object

To insert a Button object into the currently edited synopsis:

1. Click on the Button function on the graphical editor toolbar (see Figure 7.24).

2. Click on the drawing area and, while maintaining the mouse button pressed, draw 
the rectangular frame into which your button will be placed. Then release the mouse but­
ton.
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Modifying the properties of a Button object

To modify the properties of a Button object:

1. Select the Button object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. The tab Properties (see Figure 7.25) presents the parameters that can be modified. The 
button has the properties of the Rectangle and the Text object. Please refer to the  Text and 
Rectangle chapters to see how to modify the Entry field properties.

4. Click on the OK button to validate your modifications.

7.3.12 The « Polyline » object

Inserting a Polyline object

To insert a Polyline object into the currently edited synopsis:

1. Click on the Polyline function on the graphical editor toolbar 
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2. Click on the drawing area to put the first point of the polyline. Release the mouse 
button.

3. Move the mouse in the drawing area till the next point of the polyline and click again to 
set this point.

4. Repeat the third step to set as many points as you wish for the polyline and finally dou­
ble click in order to finish drawing the polyline.

Modifying the properties of a Polyline object

To modify the properties of a Polyline object:

1. Select the Polyline object you want to modify.

2. Right click on the object. The contextual menu appears. Select Properties.

3. The Polyline  is  a  « line »  object,  so  only  the  tabs  Main  parameters and  Style  are 
available (see Figure 7.5 and Figure 7.6).

4. Click on the OK button to validate your modifications.
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8 Synopsis Animations

8.1 Definition
The animation is a property of a graphical element that changes its appearance or responds 

to the user keyboards or mouse interactions. There are two types of animations:

• Properties  animations:  they  modify  the  appearance  elements  (style  properties, 
position  properties  ...)  according  to  the  value  changes  of  the  variables  to  which  the 
animations are associated. The synopsis elements are updated in real time.

• Control animations: they allow the user to interact with the synopsis, via the mouse 
or the keyboard. These animations allow the user to modify the values of variables, to open 
or close windows.

8.2 Associating an animation

The  principle  of  associating  an  animation  to  an  element  is  the  same for  all  graphical 
elements and for all animations.

1. Select the graphical element to which the animation should be associated.

2. Click in the graphical editor toolbar, on the animation function you wish to associate to 
the selected element. The animation is automatically added to the element and the properties 
window of the element is displayed.

3. In the properties window, a new tab has been added, which contains the properties of 
the associated animation.

It is possible to associate an animation to a graphical element from its contextual menu, by 
choosing Animation and then the animation to associate.
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8.3 Associating more than one animation

It is necessary sometimes to associate more than one animation to a graphical element. 
There are no constraints, but please take into consideration the following remarks:

• There is no defined priority for executing the animations. For example, if two color 
animations are associated to the same element, its appearance will depend on the most recently 
value change of the variables to which to animations apply.

• The animated elements are updated only when the value of the variable changes.

• For each animation associated to an  element,  a  tab is  associated in  the  properties 
window element.

8.4 Deleting an animation 

To delete an animation without deleting its owner graphical element:

1. Display the properties window of the owner element of the animation to delete.

2. Select the animation tab to delete.

3. Click on the Delete animation button.

Use  the  Delete  animation button  with  caution,  because  the  animation  is  removed 
immediately and no cancel action is available. That means, no undo action is available, and also the 
Cancel button does not apply to the animation removal.
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8.5 Allocating a variable to an animation 
When allocating a variable, the gateway does not need to be connected to the network. 

Indeed, the user defines the variables for the current project and this list is stored on the user 
computer in the project directory. These variables will be used for the animations.

To create the variable list, the user has the possibility to create, modify and delete a 
variable. Each time, the variable properties are displayed and edited in the bottom area of the 
variable browser. When choosing the buttons for validating, modifying or deleting a variable, the list 
of variables displayed in the top area of the variables is updated.

To allocate a variable to an animation:

1.  Apply the animation to the graphical element (see chapter ). 

2. Display the properties window of the graphical element.

3. Select the tab of the animation for which you wish to allocate a variable.

4. Click on the selection variable button  in the Condition area (see Figure8.1).

5. The variable browser dialog is displayed (see Figure8.2).

6. If no variable appears in the list, the user should define some variable. Please refer to 
the previous paragraph for how creating the variable list.

7. Select a variable and choose OK to validate.

8. The variable name is displayed in the Condition area.

9. Click on OK to validate the modification of the animation.
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8.6 Available Animations

This paragraph presents all available animations.

8.6.1 Hyperlink Animation

This animation displays a new Internet Explorer page when the user clicks on the owner 
object.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.3 shows the configuration tab of this animation.

To configure the parameters of the Hyperlink animation:

1. Select the  Hyperlink tab in the properties window element.
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2. To fill in the link to open, two options are available: 

1. Choose a synopsis from the same project from the combo list Link.

2. Write a valid « http:// » url to open.

3. Check the box  New window  to open the link in a new Internet Explorer window. By 
default, the link is opened in the same window.

4. Click OK to validate your changes.

8.6.2 Close Animation

This animation closes the current Internet Explorer page.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.4 shows the configuration tab of this animation.
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This animation has no parameters. Once this animation associated to a graphical element, 
it is activated and needs no complementary configuration.

8.6.3 State Colors Animation

This animation modifies the fill and stroke colors of the owner graphical element, according 
to the values of a boolean-type variable.

Graphical elements concerned

Line, Rectangle, Ellipse, Quart ellipse, Half ellipse, Polyline, Polygon, Bezier Shape, Bezier 
Curve, Button.

Configuration of the animation

The Figure 8.5 shows the configuration tab of this animation.

To configure the parameters of the State colors animation:

1. Select the tab Colors state in the properties window element.

2. Select the variable to associate to this animation (see chapter 8.6). 

3. Configure the Fill colors and Stroke colors areas.
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4. Click the OK button to validate the modifications.

Configuration of the colors 

To configure the fill or stroke colors:

1. Select the state of the variable for which you want to have the color changed, by check­
ing the box associated to the corresponding state.

2. Click on the  button, select the color of the graphical element when the variable 

has the chosen state, and then click OK to validate.

3. Click OK to validate the modifications.

The available states are:

• State 0: The variable is 0

• State 1: The variable has another value than 0.

• State unknown: The value is uncertain.

All variables can be used by this animation. A state different of 0 is considered as 1.

8.6.4 Group State Colors

This animation changes the stroke or fill color of a graphical element according to four vari­
ables grouped in a quartet and 16 fill colors and 16 stroke colors for the 16 quartet combinations.

Graphical elements concerned

Line, Rectangle, Ellipse, Quart ellipse, Half ellipse, Polyline, Polygon, Bezier Shape, Bezier 
Shape.

Configuration of the animation

The Figure 8.6 shows the configuration tab of this animation.
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To configure the parameters of the Group State Colors animation:

1.  Select the tab Group State Colors in the properties window element.

2. Select the four variables associated to this animation (see chapter 8.6). The variable 1 
corresponds to the bit 0 of the quartet, the variable 4 to the bit 3 of the quartet.

3. Select the check boxes for which you wish the graphical object change its color.

4. Select the  buttons and select the colors associated to each quartet combination.

5. Repeat the steps 3 and 4 for the stroke animations.

6. Click on the OK button to validate your modifications.

8.6.5 Level Colors Animation
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This animation changes the stroke or fill  color of a graphical  element according to the 
threshold reached by the value of the associated variable.

Graphical elements concerned

Line, Rectangle, Ellipse, Quart ellipse, Half ellipse, Polyline, Polygon, Bezier Shape, Bezier 
Shape.

Configuration of the animation

The Figure 8.7 shows the configuration tab of this animation.

To configure the parameters of the Level Colors animation:

1. Select the tab Group State Colors in the properties window element.

2. Select the variable associated to this animation (see chapter 49).

3. Fill in the threshold values.

For example, by denoting val1, val2, val3 and val4 the values entered in the text fields, the 
following intervals are defined:

• interval 1: the value of the variable <= val1
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• interval 2: val1 <= the value of the variable <= val2

• interval 3: val2 < the value of the variable <= val3

• interval 4: val3 < the value of the variable <= val4

1. Select the checkbox corresponding to each interval, and the checkbox FillColors (resp 
StrokeColor) if you wish to animate the fill color (resp the stroke color) of the element.

2. Click on the  button and choose the color.  

3. The last two lines Out of level values and Invalid value allow to configure the colors 
when the value of the variable is out of levels, resp invalid.

4. Click on the OK button to validate your modifications.

8.6.6 The Bargraph Animation

This animation fills a shape-type element, according to the associated variable. The fill is 
calculated using the value of the variable with respect to its range and the height (or width) of the 
drawing element.

Graphical elements concerned

Rectangle.

Configuration of the animation

The  Figure 8.8 shows the configuration tab of this animation.

57



To configure the parameters of the Bargraph animation:

1. Select the tab Bargraph in the properties window element.

2. Select the variable associated to this animation (see chapter 8.5). 

3. The list Direction allows to choose the fill direction:

• up: The fill is done from bottom to top.

• down: The fill is done from top to bottom.

• left:  The fill is done from left to right.

• right:  The fill is done from right to left.

• horizontal: The fill is done from the vertical median to the vertical extremities.

• vertical: The fill is done from the horizontal median to the horizontal extremities.

• half-horizontal: The fill  is done from the vertical median to the right while the 
value of the variable is higher than the median of the values bounds. The fill is done from the 
vertical median to the left while the value of the variable is less than the median of the 
values bounds.

• half-vertical: The fill is done from the horizontal median to the top while the value 
of the variable is higher than the median of the values bounds. The fill is done from the 
horizontal median to the bottom while the value of the variable is less than the median of 
the values bounds.

4. Enter the bounds values:

58 User Manual

Figure 8.8



• Min value: Value of the variable that corresponds to an empty bargraph.

• Max value: Value of the variable that corresponds to a full bargraph.

• Min bound value: Minimum threshold that brings out a change of the element color. 
The out of bounds color is used as a fill color.

• Max bound value: Maximal threshold that brings out a change of the element color. 
The out of bounds color is used as a fill color.

5. Click on the out of bounds color button to choose the color.

The out of bounds color is used as the fill color for the graphical element while the value of the 
variable is greater or less than the min bound, respectively the max bound value.

6. Select the invalid state color button to choose the color.

 The invalid state color is used as the fill color for the graphical element while the value of the 
variable is unknown.

7. Click on the OK button to validate your modifications.

8.6.7 The Rotation Animation

This animation represents the value of the associated variable by an angular movement. A 
typical example of its use is to move the needle in a simulation of an analogue meter.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.9 shows the configuration tab of this animation.
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To configure the parameters of the Rotation animation:

1. Select the tab Rotation in the properties window element.

2. Select the variable associated to this animation (see chapter 8.5).

3. Enter the angles values:

• Angle min: Angle between the vertical and the position of the element, while the 
value of the variable is less or equal to a min value.

• Angle max: Angle between the vertical and the position of the element, while the 
value of the variable is greater than a min value.

4. Enter the variable bounds values:

• Min value: The value of the variable that correspond to a rotation Angle min with 
respect to the actual position of the graphical element.

• Max value: The value of the variable that correspond to a rotation Angle max with 
respect to the actual position of the graphical element.

5. Click on the OK button to validate your modifications.

Example: The following parameters

• Variable: rotationSpeed

• Angle min = 0         Min value = 0
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• Angle max = 360               Max value = 360 tr/min

will change the position of the element, by rotating it 1° while the rotationSpeed increases 
of 1 tr/min. When the rotationSpeed is greater than 360 tr/min, the element will not be animated.

Rotation takes place about the element's transformation point.

Rotation  is  done  is  clockwise  for  increasing  values  of  angle  and  anti-clockwise  for 
decreasing values.

8.6.8 The Translation Animation

This animation moves an element according to its associated value.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.10 shows the configuration tab of this animation.
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To configure the parameters of the Translation animation:

1. Select the tab Translation in the properties window element.

2. Select the variable associated to this animation (see chapter 8.5). 

3. Enter the translation amplitudes:

• X axis amplitude: the horizontal movement (in pixels), it can be positive or nega­
tive. Positive values cause movement from the left to the right of the screen, and negative 
values cause movement from the right to the left of the screen.

• Y axis amplitude: the vertical movement (in pixels), it can be positive or negative. 
Positive values cause movement from the top to the bottom of the screen, and negative val­
ues cause movement from the bottom to the top of the screen.

4. Enter the variable ranges: 

• Min value:  The value of  the variable for  which the translation  is  null,  e.g.  The 
position of the element is the original position.

• Max value: The value of the variable for which the translation is maximal.

5. Click on the OK button to validate your modifications.

If the variable value is out of defined variable ranges, the element is not animated.

8.6.9 The Display Value Animation

This animation displays the value of the associated variable.

Graphical elements concerned

Text, Entry Field.

Configuration of the animation

The Figure 8.11 shows the configuration tab of this animation.

62 User Manual



To configure the parameters of the Display Value animation:

1. Select the tab Display Value in the properties window element.

2. Select the variable associated to this animation (see chapter 8.5). 

3. The list  Number of decimal digits allows to enter the number of decimal to display. 
This number shall be between 0 and 6.

4. Click on the OK button to validate your modifications.

8.6.10 The Show/Hide Animation

This animation allows to display/hide the element to which it is associated, according to a 
variable value.
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Graphical elements concerned

All

Configuration of the animation

The Figure 8.12 shows the configuration tab of this animation.

To configure the parameters of the Show/Hide animation:

1. Select the tab Show/Hide in the properties window element.

2. Select the variable binded to this animation (see chapter 8.5). 

3. Select  the condition:

• less: The  element  is  displayed  while  the  value  is  less  than  the  threshold  1, 
otherwise it is hidden.

• less or equal: The element is displayed while the value is less than or equal to the 
threshold 1, otherwise it is hidden.

• equal:  The  element  is  displayed  while  the  value  is  equal  to  the  threshold  1, 
otherwise it is hidden.

• greater: The element is displayed while the value is greater than  the threshold 1, 
otherwise it is hidden.
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• greater or equal: The element is displayed while the value is greater than or equal 
to the threshold 1, otherwise it is hidden.

• between: The element is displayed while the value is between the threshold 1 and 
the threshold 2, otherwise it is hidden.

4. Enter the thresholds values.

5. Click on the OK button to validate your modifications.

8.6.11 The Pilot Entry Field Animation

This  animation  allows  the  user  modify  the  associated variable  and  set  it  to  the  value 
entered in the entry field.

Graphical elements concerned

Entry field

Configuration of the animation

The Figure 8.13 shows the configuration tab of this animation.
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To configure the parameters of the Pilot entry field animation:

1. Select the tab Pilot entry field in the properties window element.

2. Select the variable associated to this animation (see chapter 8.5). 

3. Enter the Min value:  the minimum value accepted for the entry field.

4. Enter the Max value:  the maximum value accepted for the entry field.

5. Click on the OK button to validate your modifications.

If you wish that the entry field displays the value of the variable, you should also associate 
a Display value animation to the element and configure it with the same variable.

8.6.12 The Set Variable Animation

This animation allows the user to modify the associated variable and to set a specified 
value when the user clicks on the graphical element.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.14 shows the configuration tab of this animation.

To configure the parameters of the Set var animation:

1. Select the tab Pilot entry field in the properties window element.

2. Select the variable binded to this animation (see chapter 8.5). 

3. Check the checkbox  Mouse down related value and enter the value to be set to the 
variable, if you wish to modify the variable when the mouse button is pressed.

4. Check the checkbox Mouse up related value and enter the value to be set to the vari­
able, if you wish to modify the variable when the mouse button is released.

5. Click on the OK button to validate your modifications.
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8.6.13 The Slider Animation

This animation allows the user to click and drag the drawing element to set the value of the 
associated variable.

Graphical elements concerned

All

Configuration of the animation

The Figure 8.15 shows the configuration tab of this animation.
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To configure the parameters of the Slider animation:

1. Select the tab Slider in the properties window element.

2. Select the variable binded to this animation (see chapter 8.5).

3. Enter the amplitudes:

• X axis movement: the horizontal movement (in pixels).

• Y axis movement: the vertical movement (in pixels).

4. Enter the variable ranges:

• Min value: value to affect to the variable when the translation is null (the object is 
in its initial position).

• Max value: value to affect to the variable when the translation is maximal.

5. Click on the OK button to validate your modifications.

If you wish that the element moves when the value of the variable changes, you should also 
associate a Translation animation to the element and configure it with the same variable.
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9 Export a project

Once your synopsis finished, you can transfer the project to the gateway. This is done in 
two steps. First, the project is generated, second the project is downloaded to the gateway.

When downloading the project to the gateway, a ftp account with full access to the file 
system should be used.

9.1 Building and Transferring the Project to 
the Gateway

In order to generate a project:

1. Check whether the information concerning the gateway is correct (see chapter 5.4.2).

2. In the Project Explorer View, select the project to export.

3. Display the contextual menu of the project, by a right click, and then select Export.

4. The building project window shows. (see Figure 9.1)

5. Click the Generation button.

6. When generation is completed, the transfer window displays (see Figure 9.2)

7. Click the Transfer button.

8. Once the transfer finished, you can close the window.
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